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Chapter 1: Timbuktu Pro for Mac OS

Welcome to Timbuktu Pro!

Timbuktu Pro offers total access to your network as well as point-to-point access 
to non-networked computers. You can use Timbuktu Pro to control and observe 
other computers, send messages and files, and chat or speak with remote users 
in real time. Timbuktu Pro works over the Internet and your company’s local intra-
net to make information sharing easy. 

Plus, If you need to collaborate with a distant user who is not connected to any 
network, or you’re on the road, you can use Timbuktu Pro’s Dial Direct feature to 
establish a direct modem-to-modem connection—with no network required.

Timbuktu Pro Services

Timbuktu Pro’s simple, powerful interface provides you with the following 
services:

• Send lets you send messages, files, and folders to a remote computer.
• Exchange lets you access the hard drive of a remote Timbuktu Pro computer—

even a Windows PC. You can copy and move files and folders between com-
puters and delete files from either computer.

• Control lets you control a remote computer from your own desktop.
• Observe lets you observe a remote computer’s desktop without controlling it.
• Notify alerts you when a remote Timbuktu Pro computer becomes active.
• Chat lets you carry on a keyboard conversation with a remote user.
• Intercom lets you speak directly to a remote user through your computer’s 

audio hardware.
• Invite lets you ask other users to visit your computer using a service you 

specify.
• Profile lets you generate a full system profile for the remote computer and 

save it as a text file on your Macintosh.

See “Chapter 5: The Timbuktu Pro Services” on page 57 for detailed information 
about each service.
| 7
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Connecting with Timbuktu Pro

When you’re at the office, Timbuktu Pro runs over your company’s local area net-
work (LAN) for easy conferencing and information sharing. When you’re home or 
traveling, you can log on to a remote access server and use Timbuktu Pro to take 
direct control of your office computer. You can even use your modem to dial di-
rectly into the modem of another computer, with no network connection required. 

Once you connect to a remote computer with Timbuktu Pro, you can run “LAN-
locked” software at its normal speed, dramatically decreasing over-the-phone de-
lays of applications such as relational databases and electronic mail. Timbuktu 
Pro gives you full access to remote resources, but transfers only screen, keyboard, 
and mouse information—you don’t have to move large amounts of data over slow 
telephone links. Timbuktu Pro’s fast performance is based on efficient screen-
sharing data compression.

Timbuktu Pro uses a flexible and comprehensive security scheme. You can spec-
ify many different levels of access for remote connections to your computer: you 
may allow all guests access to some services, while limiting other services to spe-
cific users that you define, and admitting other users on a case-by-case basis. 
You can even prevent remote users from connecting to your computer entirely.

How Does It Work?

Timbuktu Pro communicates with other Timbuktu Pro computers over TCP/IP 
(Transmission Control Protocol/Internet Protocol) networks or through direct 
modem-to-modem connections.

You can use Timbuktu Pro to access other computers or to provide remote access 
to your own Macintosh. Timbuktu Pro can work in both directions at once: another 
user can send files to you while you are controlling or observing a third computer. 
You can even make several outgoing connections or receive several incoming con-
nections simultaneously.

Timbuktu Pro runs in the background of your Macintosh computer. Installation 
takes only minutes. Timbuktu Pro is non-intrusive; it doesn’t replace your video, 
mouse, or other keyboard drivers. 
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Timbuktu Pro works over your LAN, WAN, DSL, cable, dial-up, or ISDN lines. You 
can use Timbuktu Pro for file transfer, remote control, and message exchange with 
other Timbuktu Pro computers anywhere in the world.

Transports

Timbuktu Pro works on TCP/IP networks. If you are connected to the Internet, you 
can use TCP/IP and Timbuktu Pro services to collaborate with other Timbuktu Pro 
users around the world. 

Timbuktu Pro includes a direct modem-to-modem protocol called Dial Direct. You 
can use Dial Direct to access a remote computer with Timbuktu, without the aid of 
an ARA or PPP server. 

To identify and set up your modem, Timbuktu Pro uses a subset of the Microsoft 
INF file format. This lets you use Microsoft INF modem files, which are created for 
Windows, directly with Timbuktu Pro for Macintosh.

What Timbuktu Pro Can Do for You

Timbuktu Pro version 7 offers all the functionality of previous versions of Tim-
buktu Pro and adds a number of new features: the Profile service, which allows 
you to run the Apple System Profiler on a remote computer and save the complete 
system profile on your computer; updated remote-control and screen-sharing 
functionality; and full support for Panther, Apple’s latest version of Mac OS X.

Timbuktu Pro version 7 takes advantage of all the latest Mac OS X features, en-
hancing your Timbuktu experience!

With Timbuktu Pro, you can

• Support end users from your desk. Save time and money in technical support 
when you use remote control to solve user problems. Take control of the 
user’s computer and solve the problem without leaving your chair.

• Train users for a fraction of the usual time and cost. Demonstrate the latest 
applications, databases, and specialized products while a remote user 
watches. Then observe and help as the user practices. Provide individual at-
tention for all remote trainees, and save the expense of travel time and 
airfare.
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• Work remotely from wherever you are. Harness the power of remote control to 
share information, transfer files, read electronic mail, access databases, and 
send quick messages across your network. You’ll discover many ways to work 
easier and smarter.

• Collaborate with remote colleagues in real time. Share screens, documents, 
and information with both Macintosh and Windows computers. Work with 
others anywhere, and confer with your colleagues using audio- or text-based 
conferencing.

• Save time by scripting a variety of Timbuktu Pro tasks. Timbuktu Pro ships 
with AppleScripts that incorporate Timbuktu’s extensive scripting implemen-
tation. Or you can create your own scripts—you can even add them to Tim-
buktu Pro’s Script menu.

• Protect your network resources. You can grant varying levels of Timbuktu Pro 
access to different users. Registered User accounts and passwords can limit 
network and Dial Direct access to your computer and provide any combina-
tion of the Timbuktu Pro services.

Who Can Connect to Your Timbuktu Pro Computer?

The first and most important answer is “No one—without your permission!” But 
once you have set up your security options, anyone who meets your connection 
criteria may connect, if they meet the following compatibility requirements:

• For TCP/IP connections, the remote computer must be on a TCP/IP network 
and be running Timbuktu Pro for Macintosh 5.2.4 or later or Timbuktu Pro for 
Windows 4.5 or later.

• For Dial Direct connections, the remote computer must have a 56 Kbps mo-
dem (or faster).

Note: If your computer is connected to a company network that is protected by a 
firewall, your Timbuktu Pro computer may only be accessible to users from your 
local network. However, firewalls can be configured to admit Timbuktu Pro traffic. 
For more information, see the Timbuktu Pro online Help and the Netopia 
Technotes at http://www.netopia.com/support/technotes.
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Timbuktu Pro Features

Timbuktu Pro includes a rich feature set that will enable you to use it more effi-
ciently and securely than ever before. From its improved remote control capability 
to its enhanced security, Timbuktu Pro is packed with features to make your net-
work work for you.

New in Version 7

Timbuktu Pro version 7 takes full advantage of the Internet as well as the most re-
cent improvements and features available in Mac OS X. You will benefit from the 
latest file sharing and collaboration service refinements. Plus, Timbuktu Pro ver-
sion 7 includes a number of new features to make it easier than ever for you man-
age your files across the network and collaborate with remote users.

Mac OS X Panther Support

Timbuktu Pro now supports Panther, Apple’s latest version of Mac OS X. Panther 
support includes fast user switching. When you change users or log in as an addi-
tional user on Panther computers, any open Timbuktu Pro connections are 
closed. However, Timbuktu Pro is not shut down. You may immediately reconnect 
any Timbuktu Pro service.

Profile Service

Timbuktu Pro now includes a new service, Profile. The Profile service allows you to 
automatically run the Apple System Profiler on a remote computer and return the 
results to your computer.

New Screen-Sharing Window

The screen-sharing window has been enhanced with a new look and new func-
tionality. The screen-sharing window now supports more grayscale and color-
depth options, and it provides new scroll-wheel and multi-button mouse support.
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Updated Terminology

To enhance your cross-platform Timbuktu Pro experience, Timbuktu Pro for Macin-
tosh and Timbuktu Pro for Windows now use the same terminology and service 
names. The previous Macintosh Look service is now called Observe; the previous 
Knock service is called Notify. In addition, the terms for remote users have been 
updated: the Public Visitor is now the Guest User, and Trusted Visitors are now 
Registered Users.

New Preferences Settings

The Control/Observe tab in the Preferences dialog box now includes two new 
options. 

• The Limit Number of Colors drop-down list specifies the maximum color 
depth sent by your computer when a remote user opens a screen-sharing 
session. A lower color depth will improve performance.

• When the Lock Out This Computer’s Keyboard and Mouse option is selected, 
and the computer is hosting an incoming screen-sharing session, keyboard 
and mouse activity on the local computer will have no effect.

In addition, the IP Locator tab now allows you to register your computer’s external 
IP address—for example, the IP address of a NAT router—rather than the local or 
internal IP address, which may not be recognized outside your network. 

Finally, the TCP Contact Port tab allows you to change the TCP port used for Tim-
buktu Pro traffic. This allows you to use more than one Timbuktu Pro host com-
puter behind a NAT router, by directing traffic intended for a specific computer to 
a unique port on that computer.

Updated TCP/IP Zones File Name

The TCP/IP Zones file no longer requires the forward slash (/) in the file name. 
TCPIP Zones is now an acceptable file name. Timbuktu Pro also recognizes an 
alias to the actual TCP/IP Zones file, which you may now place anywhere on your 
computer.

Enhanced Activity Log

The Timbuktu Pro activity log now records more Timbuktu Pro activity. In addition, 
the log file is stored in the default Mac OS X log-file folder, and you may view it 
with the Console application.
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Enhanced Exchange!Go To Menu

The Exchange!Go To menu has been extended with the Mac OS X Go menu 
shortcuts: Home, Desktop, Favorites, and Applications. 

Timbuktu Host

In Timbuktu Pro version 7, there is no longer a “Timbuktu Extension,” which ran in 
the background on Mac OS Classic computers. On Mac OS X, Timbuktu Pro uses 
the Timbuktu Host, a background application which monitors incoming Timbuktu 
Pro connections. When a connection is received, the Timbuktu Host opens the full 
Timbuktu Pro application (if it is not already running) and processes the connec-
tion normally.

Quitting the Timbuktu Host, or disabling it so it does not start automatically, pre-
vents remote users from using Timbuktu Pro to connect to your computer. For de-
tails, see “The Timbuktu Host” on page 25.

In addition, when the Only Accept Incoming Connections When Application Is 
Open option is selected on the General tab in the Preferences dialog box, Tim-
buktu Pro now runs as the logged-in user. It is no longer necessary to enter an ad-
ministrator name and password when you start Timbuktu Pro. For information 
about this option, see “General Preferences” on page 27.

Timbuktu Pro Services

Each of Timbuktu Pro’s services allows you to interact with remote computers in a 
different way; together, they help you make the most of your network. For details 
about each Timbuktu Pro service, see “Chapter 5: The Timbuktu Pro Services” on 
page 57.

Remote Control and Screen Sharing (Control and Observe)

Timbuktu Pro’s remote control feature allows you to control or observe the desk-
top of a remote computer anywhere on your network using Timbuktu Pro’s Intel-
liScreenTM technology. Timbuktu Pro’s Control and Observe services are powerful 
tools for user support, training, and collaboration. The Control service lets you 
use your keyboard and mouse to operate another computer for user support, 
training, and collaboration. The Observe service lets you watch the activity on a 
remote computer’s desktop without interfering with keyboard or mouse input.
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Timbuktu Pro automatically adapts to any video mode. The AutoScrollTM feature 
offers automatic panning as you move your pointer on the remote desktop. Thus, 
you can always view the entire screen of the remote computer, even when moni-
tor resolutions are different. You may also shrink the view of a remote desktop to 
fit the size of your remote control window. This provides you greater flexibility in 
displaying a remote computer’s desktop on your screen and allows you to create 
convenient thumbnail images of several remote computers at once.

Timbuktu Pro allows you to hide your desktop pictures and patterns when you 
share your screen with a remote user. Hiding desktop pictures and patterns im-
proves screen-sharing performance, particularly over slow connections.

The Control service fully supports Drag and Drop. For example, you can drag a file 
out of the screen-sharing window and onto your own desktop.

You can record QuickTime movies of your screen-sharing sessions. Simply click 
the QuickTime icon on the border of the screen-sharing window.

Send

You can send FlashNotesTM—messages that pop up on the recipient’s desktop—
and attach files and folders to your FlashNotes. To quickly send files, you can drag 
files and folders to the Timbuktu Sender desktop icon. File transfer is carried out 
in the background while you continue to work at your computer.

The Send service supports file recovery. If your Send session is interrupted, Tim-
buktu Pro can resume the transfer at the point at which it was interrupted rather 
than having to start over from the beginning. 

To take advantage of file recovery, Timbuktu Pro must be running continuously on 
both computers during the service interruption. 

Exchange

Timbuktu Pro makes transferring files between computers easy. With the Ex-
change service, you can copy, move, and delete files across the network—even on 
Windows computers—just as if they were on your own computer.

The Exchange menu appears whenever you connect to another computer with the 
Exchange service. In addition to the Desktop, New Folder, Open, and Remove op-
tions, the Exchange menu also provides a number of options not listed in the Ex-
change window.



Getting Started with Timbuktu Pro for Macintosh | 15
Notify, Chat, and Intercom

Communicating with other Timbuktu Pro users is more convenient than ever with 
Timbuktu Pro’s Notify, Chat, and Intercom services. Notify alerts you when a re-
mote computer becomes active. Chat allows you to have a keyboard “conversa-
tion” with another user—even with multiple users simultaneously. Intercom lets 
you have a voice conversation using your computer’s microphone and speakers—
no telephone required.

Invite

You can invite another user to access your machine. With the Invite service, you 
can “Show my screen” to a specific user.

Profile

The Profile service allows you to run the Apple System Profiler on a remote Macin-
tosh computer and automatically save the output to a text file on your computer.

Other Timbuktu Pro Features

In addition to the enhancements in Timbuktu Pro version 7, all your favorite tools 
and features from previous versions are still available.

Comprehensive Multi-Level Security

You can restrict remote access to your computer to as few or as many remote us-
ers as you wish. Anyone can access the services you provide to Guest Users. You 
can define any number of Registered Users, granting them password-protected 
access to the specific combination of user access privileges you specify. Dial Di-
rect access may also be provided on a user-by-user basis. 

If you wish to grant one-time-only access to other Timbuktu Pro services, or allow 
access only when you are at your computer, remote users can ask for permission 
to use services you have not assigned to Guest Users or to a Registered User ac-
count. The Ask for Permission dialog box opens on your screen, telling you who 
wants to connect and the service they have requested. If you choose OK, they’re 
connected. If you don’t, they aren’t.
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Connection Menu

The Connection menu is a shortcut that lets you quickly open Timbuktu Pro, turn 
transports on and off, monitor incoming connections, and get information about 
Timbuktu Pro.

Open the Connection menu by clicking on the Timbuktu Pro icon, which appears 
on the right side of the menu bar anytime the Timbuktu Host is running. 

Cross-Platform Connections

Timbuktu Pro offers remote control and file transfer between Macintosh and Win-
dows computers. You can use your Macintosh to remotely control a computer of 
either type, just as if you were seated in front of it. Timbuktu Pro also provides 
cross-platform file transfer with a convenient, one-step procedure, whether you’re 
using the Internet, a local network, or a Dial Direct connection.

Dial Direct

Timbuktu Pro’s Dial Direct feature allows you to use your modem to connect di-
rectly to the modem of any other Timbuktu Pro computer. No Internet connection 
is required. You can use any of the Timbuktu Pro services with Dial Direct.

Internet Locator

Timbuktu Pro’s Internet Locator allows you to connect to other Timbuktu Pro users 
by specifying their email addresses instead of their IP addresses. When you en-
ter an email address on the TCP/IP tab in the New Connection window, Timbuktu 
Pro automatically queries Netopia’s Internet Locator server, resolves the correct 
IP address, and connects to the remote computer. You can set up the Internet Lo-
cator on the IP Locator tab in the Preferences dialog box.

TCP/IP Scanner

The TCP/IP Scanner tab in the New Connection window helps you find and con-
nect to remote computers, even when you don’t know their IP addresses, by 
browsing your local network for active Timbuktu-compatible computers. Once the 
desired computer is found, you may connect to it without leaving the TCP/IP 
Scanner tab.
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Timbuktu Sender

The Timbuktu Sender is a desktop icon that lets you quickly send files and folders 
to other Timbuktu Pro computers. Simply drag the desired files onto the Sender 
icon and a FlashNote window will open with the files already attached.

Timbuktu Pro Connection Documents

Timbuktu Pro Connection Documents are shortcuts that allow you to start a Tim-
buktu Pro connection to a specific remote computer, using a specific service, sim-
ply by double-clicking a desktop icon or opening the shortcut with the File menu. 
Connection documents are created with the Save Connection command in the File 
menu.

Drop Senders—Customizable Send Destinations

When you open a Send window, Timbuktu Pro adds the Save Drop Sender com-
mand to the File menu. When you choose this command, Timbuktu Pro creates a 
Drop Sender desktop icon that records the destination and the files and folders 
you selected. In the future, simply double-click the Drop Sender icon to send the 
same files and folders to the same destination. 

You can also drag other items onto the Drop Sender icon, and they will be imme-
diately sent to the remembered destination.

Address Books

You can use Timbuktu Pro’s address books to help you organize the IP addresses 
and phone numbers of the remote computers you connect to frequently. An ad-
dress book is a collection of Timbuktu Pro addresses. They save you time because 
you don’t have to enter an IP address or phone number every time you make a 
connection—simply select a computer from the list.

Create address books by adding addresses from the New Connection window or 
by importing an address list from a text file. You can drag an address directly from 
a transport tab to an address book window or from one address book to another.

Activity Log

Timbuktu Pro keeps a list of all connections made to your computer. The activity 
log shows each user’s Timbuktu Pro name and network address, records when 
the user connected or attempted to connect, and specifies which services the 
user accessed. 
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In Timbuktu Pro version 7, the activity log records more Timbuktu Pro activity than 
ever before. In addition, the log file is stored in the default Mac OS X log-file 
folder, and you may view it with the Console application.

Timbuktu Pro Online Help

Timbuktu Pro’s comprehensive online Help provides a variety of ways to answer 
your questions. It contains step-by-step instructions for common procedures, as 
well as troubleshooting hints and keyboard shortcuts.

Use the Help menu to open Help from anywhere within Timbuktu Pro. Or click the 
Help button in any dialog box or window to view context-sensitive Help for that di-
alog box.

Scripting

You can create AppleScript applications or run ready-made scripts that incorpo-
rate Timbuktu Pro features. Timbuktu Pro includes a Script menu with ready-to-
run scripts.

System Requirements for Timbuktu Pro version 7

To run Timbuktu Pro version 7 for Macintosh, your computer must meet the follow-
ing hardware and software requirements.

Minimum Hardware Requirements

Timbuktu Pro requires the same minimum hardware that is required by your Mac 
OS. In addition, you’ll need

• 15 MB of available disk space 
• 128 MB of physical RAM
• An Internet (TCP/IP) network connection or a modem
• For modem connections, a 56 Kbps or faster modem
• For the Intercom service, a microphone on each computer
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Minimum Software Requirements

Timbuktu Pro requires the following software.

• Mac OS X version 10.2.8 or later 
• One copy of Timbuktu Pro software on each computer that is to make or re-

ceive your Timbuktu Pro connections 

Compatibility

Timbuktu Pro version 7 for Mac OS is compatible with Timbuktu Pro for Macintosh 
5.2.4 and later, and Timbuktu Pro for Windows 4.5 and later. Older versions of 
Timbuktu Pro are not officially supported with Timbuktu Pro version 7.



20 | Chapter 1: Timbuktu Pro for Mac OS



Chapter 2: Installing Timbuktu Pro

This chapter will guide you as you install or un-install Timbuktu Pro.

Timbuktu Pro for Macintosh, version 7, requires an activation key. In most cases, 
the first time you run Timbuktu Pro, the Activation Key dialog box is automatically 
opened. However, the activation key for Timbuktu Pro Enterprise is included auto-
matically—you are not required to enter it before using Timbuktu Pro. This allows 
you to install Timbuktu Pro Enterprise on multiple computers without entering the 
activation key each time.

Installing and Upgrading Timbuktu Pro on Mac OS X

If you have not yet installed Timbuktu Pro on your Mac OS X computer, see the fol-
lowing section, “Performing a New Installation.” 

If you have already installed Timbuktu Pro 6.0 or later, see “Upgrading your Tim-
buktu Pro Installation to Timbuktu Pro version 7” on page 22. 

Performing a New Installation

If you have not installed a previous version of Timbuktu Pro on your Mac OS X 
computer, use the following procedure to install Timbuktu Pro.

To install Timbuktu Pro on Mac OS X

You must be logged in as an administrator to install Timbuktu Pro on Mac OS X.

1. If you downloaded Timbuktu Pro from the Web, double-click the Timbuktu 
Pro.dmg file to mount the disk image. Drag the Timbuktu Pro folder to your 
Mac OS X Applications folder. 

If you received a Timbuktu Pro CD, open it and drag the Timbuktu Pro folder 
to your Mac OS X Applications folder.
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2. Open the Timbuktu Pro application folder (inside your Mac OS X Applications 
folder). Double-click the Timbuktu Pro application icon to run Timbuktu Pro 
for the first time. 

3. When requested, enter your Mac OS X user name and password. 

4. Accept the License Agreement.

5. In the Activation Key dialog box, enter your Timbuktu Pro version 7 Activation 
Key. The Activation Key is included in the Welcome email you received from 
Netopia, or in your CD case. 

6. Click OK to close the Activation Key dialog box and start using Timbuktu Pro. 

You do not need to restart your computer. 

Upgrading your Timbuktu Pro Installation to 

Timbuktu Pro version 7

If you have previously installed Timbuktu Pro 6.x or a pre-release of Timbuktu Pro 
version 7, you may upgrade to Timbuktu Pro version 7 using the following proce-
dure. If you have Timbuktu Pro 5.x or earlier installed, Netopia recommends that 
you uninstall it completely before installing Timbuktu Pro version 7. 

Timbuktu Pro version 7 includes an “auto-update” feature that eliminates the 
need for a restart when you upgrade from Timbuktu Pro 6.x.

To upgrade to Timbuktu Pro version 7

You must be logged in as an administrator to upgrade Timbuktu Pro on Mac OS X.

1. If you have modified your existing Timbuktu Scripts and Timbuktu Startup 
Items folders, or any address book files in the Timbuktu Pro folder, and wish 
to save them, drag them to your desktop.

2. If the Timbuktu Pro application is open, quit the Timbuktu Pro application by 
choosing Quit from the Timbuktu menu. (The Timbuktu Host will still be run-
ning, but the application itself is shut down.)

3. Drag the Timbuktu Pro folder from the Mac OS X Applications folder to the 
Trash. Do not empty the trash.

4. If you downloaded Timbuktu Pro from the Web, double-click the Timbuktu 
Pro.dmg file to mount the disk image. Drag the Timbuktu Pro folder to your 
Mac OS X Applications folder. 
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If you received a Timbuktu Pro CD, open it and drag the Timbuktu Pro folder 
to your Mac OS X Applications folder.

If you dragged any existing folders to the desktop in Step 1, drag them to the 
new Timbuktu Pro folder to restore them.

5. Open the new Timbuktu Pro folder and launch the Timbuktu Pro application.

Timbuktu will alert you that it has detected another version of Timbuktu Pro 
running and will ask your permission to install the new version. Click Install.

6. When requested, enter your Mac OS X user name and password. 

Note: If you are using a Timbuktu Pro connection to upgrade a remote Tim-
buktu Pro computer, your connection will be terminated at this time. Wait a 
moment for Timbuktu Pro to restart on the remote computer, and then 
reconnect.

7. Accept the License Agreement.

8. In the Activation Key dialog box, enter your Timbuktu Pro version 7 Activation 
Key. The Activation Key is included in the Welcome email you received from 
Netopia, or in your CD case. 

9. Click OK to close the Activation Key dialog box and start using Timbuktu Pro. 

You do not need to restart your computer.

Uninstalling Timbuktu Pro

If you wish to uninstall Timbuktu Pro from your computer, please use the following 
procedure.

1. Log on to your Macintosh as an administrator.

2. Quit Timbuktu Pro by choosing Quit Timbuktu from the Timbuktu menu. (The 
Timbuktu Host will still be running, but the application itself is shut down.)

3. Drag the Timbuktu Pro folder from the Applications folder to the trash. Do not 
empty the trash.

4. Optionally, open the Mac OS X volume, open the Library folder, open the 
StartupItems folder, and drag the TimbuktuStartup folder to the trash.

5. Restart your computer.
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Chapter 3: Setting Up Timbuktu Pro

Once you have installed Timbuktu Pro, you can review and change your configura-
tion settings. This chapter describes how to start and exit Timbuktu Pro and how 
to set Timbuktu Pro configuration preferences.

Starting Timbuktu Pro

When you install Timbuktu Pro on Mac OS X, the Timbuktu Pro application icon is 
displayed on the right side of the menu bar. The icon is automatically positioned 
in the available space on the menu bar.

Click the Timbuktu Pro icon to open the Connection menu, which lets you quickly 
open Timbuktu Pro, turn transports on and off, monitor incoming connections, 
and get information about Timbuktu Pro. The Connection menu appears on the 
right side of the menu bar anytime the Timbuktu Host is running. (See the follow-
ing section, “The Timbuktu Host.”)

To work with Timbuktu Pro or establish an outgoing connection, you must open 
the Timbuktu Pro application. Click the Connection menu and choose Open Tim-
buktu Pro.

If the Connection menu does not appear on your screen, the Timbuktu Host has 
been shut down. To restart Timbuktu Pro, open the Timbuktu Pro folder on your 
computer and double-click the Timbuktu Pro icon.

The Timbuktu Host

In Timbuktu Pro version 7, there is no longer a “Timbuktu Extension,” which ran in 
the background on Mac OS Classic computers. On Mac OS X, Timbuktu Pro uses 
the Timbuktu Host, a background application which monitors incoming Timbuktu 
Pro connections. When a connection is received, the Timbuktu Host opens the full 
Timbuktu Pro application (if it is not already running) and processes the connec-
tion normally.
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By default, when you start your Macintosh, the Timbuktu Host is started automat-
ically. Timbuktu Pro is available even before you log in, allowing incoming con-
nections to occur anytime your Macintosh is turned on. Also by default, the 
Timbuktu Host remains running when you quit Timbuktu Pro. The Timbuktu Pro 
icon appears in the menu bar to remind you that the Timbuktu Host is running 
and that remote users can still access your Macintosh.

You can disable the Timbuktu Host using the Only Accept Incoming Connections 
When Application is Open option on the General tab in the Preferences dialog box 
(see page 27). When this option is enabled, the Timbuktu Host does not start au-
tomatically when you start your computer; when you quit Timbuktu Pro, both the 
application and the Timbuktu Host will shut down. This prevents remote users 
from using Timbuktu Pro to connect to your computer.

To start Timbuktu Pro when the Only Accept Incoming Connections When Applica-
tion is Open option is enabled, open the Timbuktu Pro folder on your computer 
and double-click the Timbuktu Pro icon.

Quitting Timbuktu Pro

Quitting Timbuktu Pro closes all Timbuktu Pro windows and dialog boxes and ter-
minates all outgoing connections you have made. However, as long as the Tim-
buktu Host is running, incoming connections will not be affected. Remote users 
will still be able to connect to your computer using Timbuktu Pro.

To shut down the Timbuktu Host when you quit Timbuktu Pro, open the Prefer-
ences dialog box and click the General tab. Select the Only Accept Incoming Con-
nections... option. When this option is selected, the Timbuktu Host is shut down 
when you quit Timbuktu Pro. (For details, see the previous section, “The Timbuktu 
Host.”)

To quit Timbuktu Pro

• From the Timbuktu menu, choose Quit. 
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Customizing Your Timbuktu Pro Preferences

To change Timbuktu Pro’s preset behavior, choose Preferences from the Setup 
menu. The Preferences dialog box lets you specify certain configuration options 
for Timbuktu Pro. The tabs in the Preferences dialog box are as follows:

• General—Controls Timbuktu Pro general and startup preferences. See “Gen-
eral Preferences” on page 27.

• Features—Turns Timbuktu Pro transports and features on and off. See “Fea-
tures Manager” on page 29.

• Master Password—Sets an optional password restricting access to Timbuktu 
Pro’s configuration settings. See “Master Password Preferences” on page 30.

• Password Rules—Sets restrictions on the passwords used by your Registered 
Users. See “Password Rules” on page 33.

• Sound—Specifies the sounds that play when Timbuktu Pro performs certain 
actions. See “Sound Manager” on page 32. 

• Messages Received—Specifies the location of the Messages Received folder. 
See “Setting Messages Received Options” on page 34.

• Control/Observe—Sets screen-sharing window preferences. See “Con-
trol/Observe Preferences” on page 35.

• IP Locator—Specifies the email address Timbuktu Pro sends to the Internet 
Locator server. See “Setting IP Locator Preferences” on page 36.

• Proxy Server—Specifies the proxy server used to make Timbuktu Pro connec-
tions to computers outside your local network. See “Proxy Server Prefer-
ences” on page 38.

• TCP Contact Port—Specifies the TCP port used for Timbuktu Pro traffic. See 
“Setting the TCP Contact Port” on page 39.

• Dial Direct—Dial Direct preferences. See “Setting Dial Direct Preferences” on 
page 39.

The following sections describe each of these tabs.

General Preferences

The General tab in the Preferences dialog box lets you control the appearance of 
the Timbuktu Pro Button Bar and some of Timbuktu Pro’s basic functionality. It 
also lets you determine whether the Timbuktu Host will still run when you quit the 
Timbuktu Pro application.
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To change your General options

1. From the Setup menu, choose Preferences.

2. Click the General tab.

3. In the Button Bar area, choose options to control the appearance of the But-
ton Bar. Choose Display Button Text to display the name of each Timbuktu 
Pro service next to its icon.

4. Select or clear any of the following checkboxes.

• Show Splash Screen specifies whether or not to display the Timbuktu Pro 
logo when you start the program. Timbuktu Pro starts more quickly when 
the splash screen is turned off.

• Allow Only One User prevents more than one Guest User or Registered 
User from connecting to your computer at a time. If, for example, multiple 
users have access to an email-equipped computer, you may want to use 
this option to make sure that each user can process his or her email in 
private. (Note, however, that a second remote user may connect by ask-
ing for permission. This allows you to work on a remote computer 
securely, but still collaborate with other users when needed.) 

• Log Out this Computer causes Timbuktu Pro to log out all users when a 
remote Timbuktu Pro session ends. Any unsaved changes are lost when 
the computer is restarted. This option is available when you select the 
Allow Only One User option; it allows each user to access the computer in 
a “clean” state, and protects any cached passwords or open files left by 
the previous user.
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• Only Accept Incoming Connections... determines whether the Timbuktu 
Host will remain running when you quit the main Timbuktu Pro applica-
tion. If you select this option, the Timbuktu Host will be shut down when 
you quit Timbuktu Pro. This prevents remote users from connecting to 
your computer, but it also prevents Timbuktu Pro from starting automati-
cally when you restart your computer. For more information about the 
Timbuktu Host, see “The Timbuktu Host” on page 25.

5. Click Save to save your changes.

Features Manager

The Features tab in the Preferences dialog box allows you to turn on and off Tim-
buktu Pro services, transports, and features.

Select or clear the check mark in front of a transport or feature to enable or dis-
able the selected option.

Address Book Required for user-created address books—lists of frequently 
accessed computers; address book entries can be double-
clicked immediately with no need to browse the network.

Dial Direct Transport Required for outgoing and incoming Dial Direct connections. 
A modem, ISDN, terminal adapter, or other serial device is 
required for this service. 

TCP/IP Transport Required when using a Timbuktu Pro service on any type of 
TCP/IP network.
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TCP/IP Browser Required for outgoing TCP/IP connections (over a local 
TCP/IP network, SLIP, PPP, or the Internet).

TCP/IP Scanner Required to browse your TCP/IP network for active Timbuktu 
Pro computers.

Control/Observe Host

Required for incoming Control or Observe connections.

Control/Observe Client

Required for outgoing Control or Observe connections.

Send and Receive Messages

Required for incoming and outgoing Send connections 
(sending and receiving FlashNotes and files).

Exchange Files Host Required for incoming Exchange connections.

Exchange Files Client

Required for outgoing Exchange connections.

Chat Service Required for incoming and outgoing Chat connections.

Intercom Service Required for incoming and outgoing Intercom connections.

Notify Service Required for incoming and outgoing Notify connections.

Invite Service Required for incoming and outgoing Invite connections.

Profile Host Required for incoming Profile connections.

Profile Client Required for outgoing Profile connections.

Master Password Preferences

When you create a master password, you can protect access to those parts of Tim-
buktu Pro that change Timbuktu Pro’s configuration and security settings—the 
Preferences, Incoming Access, and Define Users dialog boxes. When you create a 
master password, you can specify the areas of Timbuktu Pro that are password-
protected. When you attempt to access the password-protected areas, you will 
need to enter your master password before you can proceed.
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If you protect your Timbuktu Pro settings with a master password, be sure you 
choose a password you will remember. If you forget your master password, you 
will need to uninstall and reinstall Timbuktu Pro to reset it, and all configuration 
settings and custom access privileges will be lost.

To set or change your master password

1. From the Setup menu, choose Preferences.

2. If you have an existing master password, enter it when prompted.

3. Click the Master Password tab.

4. Enter the new password in the Password box. For your security, the charac-
ters you enter are displayed as asterisks. Passwords are case-sensitive.

5. Re-type the master password in the Confirm box.

6. In the Require Master Password When area, select the actions that will 
require a master password. For maximum security, select all options. Or 
choose only the options that apply to your situation.

7. Click Save to save your changes.

Timbuktu Pro will not let you close the Preferences dialog box unless the Pass-
word and Confirm fields match exactly.
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Removing Your Master Password

If you wish to unprotect your Timbuktu Pro settings, you may remove your master 
password. Remember if you do so that anyone with access to your computer will 
be able to change your Timbuktu Pro settings.

To remove your master password

1. From the Setup menu, choose Preferences.

2. Enter your existing master password.

3. Click the Master Password tab.

4. Delete the text from both the Password and Confirm boxes.

5. Click Save to save your changes.

Sound Manager

The Sound tab in the Preferences dialog box allows you specify the sounds that 
play when Timbuktu Pro performs certain actions. To specify a sound, select an 
action in the window and choose a sound from the sound list. The sound is 
played to confirm your selection.

The sound list is created from the system sounds inside your Macintosh’s system 
folder. To add new sounds to the system folder, see your Mac OS documentation.

Click the Default Sounds button to return all sounds to their default settings.
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Password Rules

You can set password rules to increase the security of Registered User access to 
your computer. Your password rules can define an expiration date on all pass-
words, set a minimum length for all passwords, and require new passwords cre-
ated by users to be different from any of their three previous passwords.

To set password rules, choose Preferences from the Setup menu, and click the 
Password Rules tab.

Select or clear any or all of the following options.

Allow Users to Save Passwords in Connection Documents

Enables Registered Users to create Connection Documents that include the user 
name and password they use to access your computer. Enabling this option 
makes it easier for Registered Users to connect quickly, but it also enables any-
one with access to their computers to connect to your computer.

New Passwords May Match User’s 3 Previous Passwords

Enables Registered Users to reuse recently-used passwords. If the password has 
been compromised, this may reduce your security.

Allow Common Passwords

Enables Registered Users to use a password that may be easily guessed. This may 
reduce your security.
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Minimum Number of Characters in Passwords

Requires Registered Users to choose passwords of a minimum length, which may 
make them more difficult to guess.

Number of Days Until Password Expires

Requires Registered Users to create new passwords on a regular basis.

Setting Messages Received Options

When you receive a FlashNote from another computer, the FlashNote and any at-
tached files are stored in your messages received folder, which you specify in the 
Preferences dialog box. You can also designate how much of your disk space 
should be protected from temporary storage of FlashNotes and their enclosures 
and specify how Timbuktu Pro notifies you of incoming FlashNotes.

To change your Messages Received options

1. From the Setup menu, choose Preferences.

2. Click the Messages Received tab.

3. In the Messages Received Folder area, specify the disk location where incom-
ing FlashNotes and files will be stored. To protect some disk space from 
being filled by received files, enter the desired number of megabytes in the 
Don’t Allow Messages to Fill field. This prevents users from filling up your 
disk with FlashNotes and files.



Getting Started with Timbuktu Pro for Macintosh | 35
If someone attempts to send files or folders that would require more disk 
space on your computer than is available, Timbuktu Pro notifies them that 
there isn’t enough disk space to carry out the file transfer.

This option does not restrict Exchange service file transfers.

4. In the When Messages Arrive area, select the alerts that are displayed when 
you receive a FlashNote.

5. Click Save to save your changes.

Control/Observe Preferences

Control and Observe sessions take place in a screen-sharing window, which dis-
plays the contents of the remote computer’s desktop. The Control/Observe tab in 
the Preferences dialog box lets you specify how your computer will behave when 
you control or observe another computer. You can also specify how your desktop 
will appear when a remote user controls or observes your computer.

To change your Control and Observe options

1. From the Setup menu, choose Preferences.

2. Click the Control/Observe tab.

3. In the When Connecting to Other Computers area, specify whether you wish 
to accept scaled fonts, which may improve performance. 
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4. In the When Other Users Connect area, specify the number of colors dis-
played when remote users connect to your computer. Grayscale and low 
numbers of colors will improve screen-sharing performance. 

When you select the Scan Aggressively for Screen Changes option, screen 
changes are detected as they have been in previous versions of Timbuktu 
Pro. The CPU Meter is displayed at maximum usage when there is a screen-
sharing guest connected to your computer. When this option is not selected, 
CPU usage is greatly reduced. However, movies and games are not captured 
as well during screen-sharing sessions. By default, this option is not 
selected.

Finally, select or clear the Lock Out This Computer’s Keyboard and Mouse 
option. When this option is selected, and the computer is hosting an incom-
ing screen-sharing session, keyboard and mouse activity on the local com-
puter will have no effect.

5. Click Save to save your changes

The Control Menu

The Control menu includes a number of options that you may change before or 
during a screen-sharing session. Some options are not available except during an 
active screen-sharing session.

Note that if you change the color depth for the host computer during a screen-
sharing session, the screen-sharing window must be the active window in order 
for the change to take effect immediately. If the screen-sharing window is not ac-
tive when you change the color depth, the default color depth for future sessions 
will be changed but the current session will be unaffected.

Setting IP Locator Preferences

When you set up Timbuktu Pro, you can enter your email address on the IP Locator 
tab in the Preferences dialog box. When you specify an email address here, it is 
registered with the Internet Locator server. Remote users can then connect to your 
computer by entering your email address on the TCP/IP tab in the New Connection 
Window. Users will not need to know your IP address to make the connection.
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Select the Register Public Address check box to register your computer’s external 
IP address—for example, the IP address of a NAT router—rather than the local or 
internal IP address, which may not be recognized outside your network. 

Note: If there are multiple host computers behind the NAT router, you may also 
wish to set a unique TCP contact port for each computer. See “Setting the TCP 
Contact Port” on page 39.

Advanced Settings

Click the Advanced button to override the default Internet Locator server or de-
fault IP address for your computer. Your network administrator will notify you if 
you need to change these settings.
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Override IP Locator Server

Some network administrators may wish to use an Internet Locator server other 
than the default server. Enter the name or IP address provided by the administra-
tor in the IP Locator Server box. 

Unless your network administrator notifies you that another Internet Locator 
server has been set up, leave this setting blank.

Override Registered IP Address

You may need to change the IP address that Timbuktu Pro sends to the Internet 
Locator server if you are behind certain types of routers or firewalls. Enter the IP 
address provided by the administrator in the Registered Address box. 

Unless your network administrator notifies you that another IP address is re-
quired, leave this setting blank.

Proxy Server Preferences

Timbuktu Pro allows connections over an HTTP proxy server. Depending on the 
configuration of your firewall, you may need to use a proxy server when you’re 
making Timbuktu Pro connections to computers outside your local network. Your 
network administrator can tell you if you need to use this feature and help you 
configure your Timbuktu Pro preferences.

Specify a proxy server on the Proxy Server tab in the Preferences dialog box.
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Setting the TCP Contact Port

The TCP Contact Port tab in the Preferences dialog box allows you to specify the 
TCP port used for Timbuktu Pro traffic. This allows you to use more than one Tim-
buktu Pro host computer behind a NAT router, by directing traffic intended for a 
specific computer to a unique port on that computer.

Note: To ensure successful connections, you may also wish to register your com-
puter’s external IP address, rather than the local or internal IP address, which may 
not be recognized outside your network. See “Setting IP Locator Preferences” on 
page 36.

Setting Dial Direct Preferences

The Dial Direct tab in the Preferences dialog box lets you specify your modem’s 
properties and control the way in which your modem responds to incoming calls.

In most cases, the default settings are suitable. Do not change the Modem Con-
nection or Modem Handling settings unless you are experienced with modem 
configuration.

By default, Timbuktu Pro will not answer  incoming Dial Direct calls. If you wish to 
accept Dial Direct connections, you must set up Dial Direct privileges in the Define 
Users dialog box. You may grant Dial Direct access to Guest Users (which allows 
anyone to use Dial Direct to connect to your computer) or assign it only to specific 
Registered Users. See “Setting up Timbuktu Pro for Incoming Dial Direct Access” 
on page 76.
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To change your Dial Direct options

1. From the Setup menu, choose Preferences.

2. Click the Dial Direct tab.

3. In the Modem Connection area, select the modem or port that you want to 
use with Dial Direct. Make sure that the modem or port you select is not 
being used by some other application.

4. Under Modem Handling, choose a radio button and provide the required 
modem configuration information. You may determine the degree to which 
you want to customize your modem settings.

• Choose Standard to let Timbuktu Pro determine your modem configura-
tion. The Standard setting is suitable for the majority of modems.

• Choose Special and click the Modem button to select a preset configura-
tion for your modem. (See the following section, “Modem Picker.”) You 
can select your own modem-specific configuration without too much con-
figuration detail. Choose a modem configuration from your computer’s 
list of modem configuration (INF) files, stored in the Timbuktu Pro appli-
cation bundle on Mac OS X and in the System Folder:Extensions:Modem 
Descriptions folder on Mac OS 8 and 9. 

• Choose Custom to use all of Timbuktu Pro’s tools to fine-tune your 
modem settings. Custom enables all of the Modem Handling options: 
Modem, Port Speed, Make Modem Ignore DTR, and Custom Init. Unless 
you are experienced with modem configuration, custom modem configu-
rations are not recommended. See your modem documentation for more 
details.
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5. In the When Answering Calls area, specify the number of times your modem 
should ring before answering an incoming call. The default setting is 1. (Note 
that calls will not be answered if you have turned off the Dial Direct transport 
in the Incoming Access dialog box.)

You may also turn on your modem speaker if you wish to monitor the 
progress of your outgoing connections.

6. Click Save to save your changes.

Modem Picker

The Modem Picker allows you to select the configuration data that applies to your 
modem. When you specify the Special modem handling option on the Dial Direct 
tab in the Preferences dialog box, you can use the Modem Picker to select a pre-
set configuration for your modem.

The Modem Picker dialog box lists modem manufacturers and their modem types. 
The Modem Picker creates its list of modem configuration (INF) files from the INF 
files stored in the Timbuktu Pro application bundle on Mac OS X and in the Sys-
tem Folder:Extensions:Modem Descriptions folder on Mac OS 8 and 9. 

Choose your modem manufacturer and model from the list and click OK.

If you don’t find a modem make and type for the modem that’s attached to your 
computer, choose the Generic Modem option. If the Generic Modem selection 
doesn’t work, see the following section, “Modem Information Files and Custom 
Modem Configuration.”

Modem Information Files and Custom Modem Configuration

If you must specify your modem configuration manually, choose Standard or Cus-
tom in the Modem Handling area on the Dial Direct tab in the Preferences dialog 
box. You can add a new modem information file or use a custom modem initial-
ization string. Unless you are experienced with modem configuration, custom mo-
dem configurations are not recommended. See your modem documentation for 
configuration information, or contact Netopia Technical Support.
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Preparing to Make Dial Direct Connections

Before you can use Timbuktu Pro to make outgoing Dial Direct connections, you 
must set up your modem and calling locations.

To set up Timbuktu Pro for incoming Dial Direct connections, see “Setting up Tim-
buktu Pro for Incoming Dial Direct Access” on page 76.

Configuring Timbuktu Pro for Your Modem

Configure your modem for the Dial Direct feature using the Dial Direct tab in the 
Preferences dialog box. See “Setting Dial Direct Preferences” on page 39.

Setting Your Calling Location

Before you can use the Dial Direct service to make outgoing connections, you’ll 
need to enter your calling location. 

Your calling location tells Timbuktu Pro how to dial out of various telephone envi-
ronments, such as different office, home, or hotel locations. After you’ve defined 
your calling locations, you need only select the one that matches your current lo-
cation before using the Dial Direct feature to place a call.

Your calling location is particularly important if you’re using callback. If you’re us-
ing callback, make sure that your calling location information is filled out accu-
rately and that the appropriate calling location is selected. The computer that will 
be calling you back reads your telephone number from the calling location you 
specify. If the number is incorrect, the callback will fail. For more information 
about callback, see “Choosing Callback Options” on page 78.

To enter a calling location

1. Make sure you have set your Dial Direct preferences. See “Setting Dial Direct 
Preferences” on page 39.

2. From the Setup menu, choose Calling Locations. 

3. In the Calling Locations dialog box, click New to create a new location.
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4. In the New Location dialog box, enter the relevant information in each field.

• The Dialing Prefix field can be used to disable call waiting before making 
a modem connection (contact your local telephone company to deter-
mine the correct prefix) or to reach an outside line if you’re dialing from 
within a company telephone network.

• Use the credit-card information fields if you must pay for the call using a 
credit card.

• The Country Code, Area Code, and Phone Number boxes should contain 
the number you are calling from. This information is used for callback. 
See “Choosing Callback Options” on page 78 for information about each 
option.

5. Click Save to save your changes.

Controlling Access to Your Computer

There are several ways to maintain security and restrict access to your computer 
by other Timbuktu Pro computers. You may use a master password to prevent any-
one with direct access to your computer from changing your Timbuktu Pro prefer-
ences. (See “Master Password Preferences” on page 30.) 

In addition, no remote computer can connect to your computer without your prior 
authorization. There are several levels of remote access: you may assign privi-
leges to all Guest Users, allow remote users to ask for permission to use unas-
signed services, and create Registered Users with specific privileges. The setup of 
various security measures is discussed in detail in “Chapter 6: Security” on page 
71.

Finally, to quickly prevent all user access to specific services or transports, you 
may turn off the selected service on the Features tab in the Preferences dialog 
box. (See “Features Manager” on page 29.)
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Chapter 4: Making a Timbuktu Pro Connection

This chapter discusses how you can use the New Connection window to connect 
to remote computers. The different tabs in the New Connection window give you 
several different ways to find the remote computer you need, and the Button Bar 
allows you to connect quickly to the computer you’ve selected.

As long as you have been granted access as a Guest User, Ask for Permission 
User, or Registered User, you can connect to any computer that is running Tim-
buktu Pro over a TCP/IP network. If you have a 56 Kbps or faster modem, you may 
also make a direct modem-to-modem connection, with no network required.

The New Connection Window

The New Connection window contains tabs that let you choose network or dial-up 
addresses. The New Connection window also features a tab that allows you to or-
ganize your Timbuktu Pro address books. A tab is displayed only if the associated 
software has been installed and configured. For example, the Dial Direct tab may 
not be available on some computers.

You’ll use the New Connection window whenever you need to find or enter a Tim-
buktu Pro address for the first time. If all the addresses you need have been 
saved in an address book, you can leave the New Connection window closed and 
work directly from your address book.

To display the New Connection window, click the File menu and choose New 
Connection.
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You can establish a Timbuktu Pro connection by specifying a remote computer in 
the New Connection window and then specifying a service using the Button Bar or 
the Services menu. 

Tabs in the New Connection Window

The New Connection window includes multiple tabs: Address Books, Dial Direct, 
TCP/IP, and TCP/IP Scanner. 

Note: Mac OS X does not support AppleTalk. Previous Timbuktu Pro users will 
notice that the AppleTalk tab no longer appears in the New Connection window.

Address Books Tab

The Address Books tab in the New Connection window lists your Timbuktu Pro ad-
dress books. (They are also listed in the File menu.) You can use address books to 
keep your favorite addresses organized. Use multiple address books to group ad-
dresses into convenient clusters: for example, business contacts, friends, and 
family. See “Using the Address Books” on page 51.

Dial Direct Tab

The Dial Direct tab in the New Connection window allows you to make a direct mo-
dem-to-modem connection to another Timbuktu Pro computer equipped with a 
56 Kbps (or faster) modem and a version of Timbuktu Pro that supports Dial Direct 
connections. No TCP/IP network connection is required. See “Making a Dial Direct 
Connection” on page 54.
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TCP/IP Tab

The TCP/IP tab in the New Connection window lets you connect to a remote com-
puter on a TCP/IP network using its IP address or DNS name. You may also use the 
remote user’s email address to make a connection if that user is registered with 
Netopia’s Internet Locator Server. See “Using the TCP/IP Tab” on page 48.

TCP/IP Scanner Tab

The TCP/IP Scanner tab in the New Connection window helps you find and con-
nect to remote computers, even when you don’t know their IP addresses, by 
browsing your local network for active Timbuktu Pro computers. Once the desired 
computer is found, you may connect to it without leaving the TCP/IP Scanner tab. 
See “Using the TCP/IP Scanner to Find a Remote Computer” on page 49.

The Button Bar

Timbuktu Pro’s floating Button Bar includes a service button for each Timbuktu 
Pro service, as well as and several function buttons.

• The Dial Direct button lets you make direct dial-up connections to modem-
equipped Timbuktu Pro computers. It appears on the Button Bar if you have 
configured Timbuktu Pro properly on the Dial Direct tab in the Preferences di-
alog box.

• The Activate Modem button transfers control of your phone line from the tele-
phone (voice) to the modem (data). It eliminates the need to hang up and re-
dial when you’re dealing with a remote Timbuktu Pro computer and speaking 
to its user over a single phone connection.

• The Save Address button lets you save any selected address of a remote user 
in a Timbuktu Pro address book.

The Button Bar allows you to access any of Timbuktu Pro’s services from almost 
any Timbuktu Pro window. You can drag an address to any of the service buttons 
to initiate a session using that service.

Note: The buttons are dimmed when no remote computer’s address is selected. 

The Button Bar can be displayed in a vertical or horizontal configuration, with or 
without labels. You can set these options on the General tab in the Preferences di-
alog box. (See “General Preferences” on page 27.) When the Button Bar is hidden, 
you can display it by choosing Show Button Bar from the Window menu.
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Making a New Connection

You can establish a Timbuktu Pro connection to a computer you haven’t used be-
fore in several ways. You may enter its IP address, DNS address, or email address 
in the TCP/IP tab in the New Connection window, or you may use the TCP/IP 
Scanner tab to search your network for the computer you want.

You may also establish a Dial Direct connection (see “Making a Dial Direct Con-
nection” on page 54) or reconnect to a computer you’ve connected to in the past 
(see “Re-Establishing a Previous Connection” on page 51).

Using the TCP/IP Tab

The most common way to open a new Timbuktu Pro connection is through the 
TCP/IP  tab in the New Connection window.

To make a new connection

1. In the New Connection window, click the TCP/IP tab.

2. In the address box, enter the address of the remote computer you want to 
connect to.

You may enter the computer’s IP address or DNS name. If you don’t know the 
IP address, and the Internet Locator service is enabled on the remote com-
puter, you may enter the computer user’s email address. See “Setting IP 
Locator Preferences” on page 36 for more information about the Internet 
Locator.
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3. Choose any service from the Service menu or use the Button Bar to click on 
the service button that you want to use. For detailed information about each 
service, see “Chapter 5: The Timbuktu Pro Services” on page 57.

4. To complete the connection to the remote computer, you may need to log on 
as a Registered User or ask for permission. See the following section, “Con-
necting as a Registered User or Ask for Permission User.”

Once your connection has been established, you may wish to save it to a Connec-
tion Document to allow faster connection in the future. See “Timbuktu Pro Con-
nection Documents” on page 55.

Connecting as a Registered User or Ask for Permission User

If you attempt to connect to a remote computer using a Timbuktu Pro service that 
is not assigned to Guest Users, the Log In dialog box will appear on your screen. If 
you have a Registered User account on the remote computer, select the Regis-
tered User radio button. Enter your log in name and password and click OK. (You 
may also change your password if desired or if prompted to do so. Note that pass-
words are case-sensitive.)

If you do not have a Registered User account, you will need to ask for permission 
to access the remote computer. Select the Ask for Permission  radio button and 
click OK. If the user of the remote computer grants your request, you will be ad-
mitted.

Note: The user of the remote computer may have disabled the Ask for Permission 
option for the service you’ve requested. If the Ask for Permission  radio button is 
not available, you must use other means to contact the remote user to be granted 
access.

Using the TCP/IP Scanner to Find a Remote Computer

The TCP/IP Scanner tab in the New Connection window helps you find and con-
nect to remote computers, even when you don’t know their IP addresses, by 
browsing your local network for active Timbuktu Pro computers. When you find 
the desired computer, you may connect to it without leaving the TCP/IP Scanner 
tab. 

By default, the TCP/IP Scanner will search only your local subnet. Your system ad-
ministrator can customize and extend the range of the TCP/IP Scanner search.
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To find a remote user using the TCP/IP Scanner

1. In the New Connection window, click the TCP/IP Scanner  tab.

2. In the list of computers, select the computer you wish to connect to.

If the computer you need doesn’t appear, and there is a lower panel listing 
TCP/IP zones, select a different zone and click Scan. Timbuktu Pro searches 
the selected zone and lists the Timbuktu Pro computers it finds.

3. Choose any service from the Service menu, or use the Button Bar to click the 
service button that you want to use. For detailed information about each ser-
vice, see “Chapter 5: The Timbuktu Pro Services” on page 57.

4. To complete the connection to the remote computer, you may need to log on 
as a Registered User or ask for permission. See “Connecting as a Registered 
User or Ask for Permission User” on page 49.

You may want to save frequently-used TCP/IP addresses in an address book for 
more convenient access. See “Using the Address Books” on page 51.
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Re-Establishing a Previous Connection

When you connect to a remote computer using the TCP/IP tab, the IP address is 
saved in the IP Address drop-down list. You may save addresses to an address 
book (on the Address Books  tab) to make future connections easier. 

You may also save your connection to a Timbuktu Pro Connection Document. (See 
page 55.)

To re-connect to a remote computer

1. In the New Connection window, select the remote computer you wish to con-
nect to. You can select a previously connected remote computer in one of the 
following ways:

• If you have previously stored the address in an address book, select the 
appropriate address book on the Address Books  tab and click Open. 
Then select the desired computer in the address book. (See “To save an 
address to an address book” on page 52.)

• On the TCP/IP  tab, the last 20 connections you made are saved to the 
TCP/IP Address  drop-down list. Select a TCP/IP address from the list and 
choose a service.

2. Once you have selected an address, click a service button on the Button Bar 
or choose a service from the Service menu. If you select multiple addresses, 
the same service is invoked for each of the selected addresses.

Note: Double-clicking an entry in an address book launches the Control ser-
vice. You can also select the computer and press Return.

Using the Address Books

An address book is a collection of Timbuktu Pro addresses. You can add and de-
lete addresses at any time. Each address includes the computer name and its IP 
address or dialing information. 

To open an address book, double-click it on the Address Books tab in the New 
Connection window. Address books are also listed in the File menu. Choose the 
name of the address book from the File menu to open it.
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When an address appears in an address book, it does not guarantee that the 
computer at that address is currently running Timbuktu Pro. If Timbuktu Pro is not 
running on the remote computer, or if the computer is shut down, you will not be 
able to connect.

In addition, TCP/IP addresses may change. If your organization uses dynamic 
TCP/IP addressing, you may not want to store IP addresses in Timbuktu Pro’s ad-
dress books.

To save an address to an address book

1. Make sure the desired address book is open. 

2. In the New Connection window, select a computer on the TCP/IP Scanner tab, 
enter an address on the TCP/IP tab, or enter a phone number on the Dial 
Direct tab.

3. From the Service menu, choose Save in Address Book.

If only one address book is open, the menu option will change to Save in 
<address book name>. The address will be saved to this address book auto-
matically.

If multiple address books are open, the Select Address Book dialog box will 
appear. Select the desired address book and click OK. The address will be 
saved to the selected address book.
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Editing Address Book Entries

If a user’s TCP/IP address or telephone number changes, or you wish to rename 
an address book entry, you may edit it.

To change the properties of a saved address

1. Make sure the desired address book is open. (To open an address book, 
select it on the Address Books tab in the New Connection window, or choose 
the name of the address book from the File menu.)

2. In the address book window, select the address you wish to modify. In the 
address properties panel, modify the address information.

3. The modified information is saved automatically.

Creating New Address Books

By default, Timbuktu Pro includes one address book, called Personal Address 
Book. You may wish to create additional address books to organize addresses by 
function or location.

To create a new address book

1. From the File menu, choose New Address Book.

2. In the Save dialog box, navigate to the folder where you want to create the 
address book.

3. In the Save dialog box, enter a name for the new address book and click 
Save.

4. The new address book is created and is opened on your desktop.
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Making a Dial Direct Connection

The Dial Direct  tab in the New Connection window allows you to make a direct mo-
dem-to-modem connection to another Timbuktu Pro computer equipped with a 
modem and a version of Timbuktu Pro that supports Dial Direct connections. No 
network connection is required.

Use the text boxes and drop-down lists to enter the complete phone number you 
wish to dial, and click Dial.

After Timbuktu Pro has established a modem connection to the remote computer, 
either you or the other user can initiate a service.

To establish a Dial Direct connection

1. In the New Connection window, click the Dial Direct tab.

2. If you are making an international call, enter a country code in the Country 
Code box. If you do not enter a country code, Timbuktu Pro will not dial one. 
(Note that you cannot enter a country code unless you choose International 
from the Call Type drop-down list.)

3. Enter the area code in the Area Code  box. If you do not enter an area code, 
Timbuktu Pro assumes that you are making a local call and will not dial an 
area code. (Note that you cannot enter an area code unless you choose Inter-
national or Long Distance from the Call Type drop-down list.)

4. Enter the phone number in the Phone Number  box.
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5. If desired, specify your current location in the Calling From drop-down list. 

Calling locations allow you to save dialing information associated with the 
various locations from which you may place calls. To set up calling locations, 
see “Setting Your Calling Location” on page 42.

6. If necessary, select the Request Callback or Modem Speaker On checkbox.

If you’re using callback, make sure that your calling location information is 
filled out accurately and that the appropriate calling location is selected. The 
computer that will be calling you back reads your telephone number from the 
calling location you specify. If the number is incorrect, the callback will fail. 
See “Setting Your Calling Location” on page 42. 

7. The complete phone number is displayed at the Number to Dial  line exactly 
as it will be dialed. If you have disabled call waiting in the Dialing Properties 
dialog box, or if you have indicated a number (usually 9) you must dial to 
reach an outside line, the appropriate dialing sequence will be displayed 
preceding the number.

8. Choose Dial to dial the number and begin a Dial Direct connection. The 
Modem Status window will appear to help you monitor your connection.

Once the connection is established, you (or the user of the remote computer) may 
launch any Timbuktu Pro service normally. All services work in the same way as 
they do over a TCP/IP connection. 

Timbuktu Pro Connection Documents

Timbuktu Pro Connection Documents are shortcuts that allow you to start a Tim-
buktu Pro connection to a specific remote computer by double-clicking a desktop 
icon or opening the shortcut with the File menu. Connection documents are cre-
ated with the Save Connection command in the File menu.

For example, if you have a file that you update and send to a number of other us-
ers on a weekly basis, you could put that file in a FlashNote, enter a message, 
choose the destinations, and save a connection document. The next time you 
need to distribute that file, simply update the file, open the connection docu-
ment, and click Send.
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To create a new Connection Document

1. Establish a connection to a remote computer using the service you wish to 
save in the connection document. You may make the connection using any 
available protocol. If necessary, log in to the remote computer as a Regis-
tered User or Ask for Permission User.

2. With the connection and service active, open the File menu and choose Save 
Connection.

3. Specify a name and location for the connection document.

4. If the Save Password checkbox is available, you may select it. This will 
streamline your next connection by sending your user name and password 
automatically. However, this will allow anyone with access to your computer 
to establish a connection using your identity.

The Save Password checkbox will not be available if you are connecting to a 
Windows computer, or if the host computer has not enabled the Save Pass-
words in Connection Documents option on the Password Rules tab in the 
Preferences dialog box.

5. Click Save to save your changes.

You may now close the connection.

To re-establish a connection using a connection document

• Double-click the connection document on the desktop or in the Finder, or 
choose Open from the File menu and specify the connection document. 

The connection will be reestablished. (You may need to log in as a Registered 
User or ask for permission to complete the connection.)



Chapter 5: The Timbuktu Pro Services

This chapter introduces you to Timbuktu Pro’s user interface and terminology. It 
also explains how to use each Timbuktu Pro service: Send, Exchange, Control, Ob-
serve, Notify, Chat, Intercom, Invite, and Profile. (The Control and Observe ser-
vices are collectively known as Remote Control.) Each Timbuktu Pro service allows 
you to interact with remote computers in a different way; together, they help you 
make the most of your network.

Send: Sending FlashNotes and Files to Remote Computers

Timbuktu Pro’s Send service can send messages similar to electronic mail, called 
FlashNotes, to another computer. You can also attach files and folders to the mes-
sages and send them to other computers. Timbuktu Pro temporarily stores the 
files you send in a specific folder on the remote computer. 

Likewise, remote users can send files only to your messages received folder, 
which you specify on the Messages Received tab in the Preferences dialog box. 
Send does not  allow remote users to see the folders on your computer. Once you 
receive the files, you can save them to any directory you wish. (See “Receiving 
FlashNotes” on page 60.)

To send a FlashNote to a remote computer

1. Select the remote computer or establish a Dial Direct connection. (See 
“Chapter 4: Making a Timbuktu Pro Connection” on page 45.)

2. From the Service menu, choose Send. Or click the Send service button. The 
Send window opens. (Note that you may need to ask for permission or log in 
as a Registered User before the window opens.)
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3. If desired, click the Add button next to the Destinations panel to add addi-
tional computers to the list of recipients.

4. To send a note, type a message in the Message panel. 

5. To include files with your message, click the Add button next to the Enclo-
sures panel, make your selection in the Add Files or Folder dialog box, and 
click Add.

Note: You may also drag and drop files and folders from the desktop into the 
Enclosures area in the Send window.
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6. If you established a Dial Direct connection to the remote computer, the Hang 
Up... checkbox will be available. Select the checkbox to close your connec-
tion automatically once the FlashNote has been sent.

7. Click the Send  button in the Send window to send the FlashNote and files. 
The Send Status dialog box appears on your screen to help you monitor the 
progress of the file transfer. 

The Send Status Dialog Box

The Send Status dialog box appears when you’re transferring files using the Send 
service.

To stop the file transfer before it is complete, click Stop. Timbuktu Pro stops the 
file transfer, but the FlashNote is still sent to the remote computer. In addition, 
stopping the file transfer does not affect files that have already been transferred.

If you established a Dial Direct connection to the remote computer, the Hang Up... 
checkbox will be available. Select the checkbox to close your connection auto-
matically once the FlashNote and its attachments have been sent.

The Show Message button reopens the Send window that you created to send the 
files and message to the remote computer.

If a problem occurs during the file transfer, the Try Again button will become ac-
tive. Click to it attempt to send the FlashNote and files again.
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Receiving FlashNotes

When you receive a FlashNote, it is automatically saved in your messages re-
ceived folder. You may specify this folder on the Messages Received tab in the 
Preferences dialog box. (See “Setting Messages Received Options” on page 34.)

The Messages Received tab also allows you to select the Open Timbuktu Pro and 
Display the Message option. If this option is selected, incoming FlashNotes will 
automatically open on your desktop. You may then reply to them, forward them, 
or send them to the trash. If you wish to save enclosures to a different location 
than the Messages Received folder, you may drag them from the FlashNote win-
dow to your desktop or to a Finder window.

The Messages Received Window

The Messages Received window lists all the FlashNotes you have received and 
not moved or deleted. To open the Messages Received window, choose Show 
Messages Received from the Window menu.

When you select a message in the Messages Received window, you can 

• Click Open to display the message and a list of any attachments. 
• Click Reply to send a message back to the original sender. 
• Click Forward to send a copy of the message to another Timbuktu Pro user. 
• Click Trash to move the message to the trash. 
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Exchange: Copying and Moving Files Between Computers

With Timbuktu Pro’s Exchange service, you can copy and move files and folders in 
both directions between your computer and another Timbuktu Pro computer. Ex-
change provides more flexibility than Send. 

To copy files and folders between computers

1. Select the remote computer or establish a Dial Direct connection. (See 
“Chapter 4: Making a Timbuktu Pro Connection” on page 45.)

2. From the Service menu, choose Exchange. Or click the Exchange  service but-
ton.

The Exchange window is displayed and the Exchange menu appears. (Note 
that you may need to ask for permission or log in as a Registered User before 
the window opens.)

The left panel lists the drives, folders, and files on your computer. The right 
panel lists the same information for the remote computer.

3. Locate and display the source and destination folders in the Drives  drop-
down lists.

You can use the New Folder  button create a new folder on either computer.

4. Drag the desired files or folders from the source panel to the desired folder in 
the destination panel.

5. Timbuktu Pro begins to transfer the files immediately. The Exchange Status 
dialog box appears, indicating the progress of the file transfer.
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While Timbuktu is transferring the files, you can

• Click outside the Exchange window, or minimize it, to work on other com-
puter tasks. 

• Click Cancel to immediately cancel the transfer. The file being sent when 
Cancel  is clicked is not transferred, but any files that were previously 
sent remain in the destination folder (unless you manually delete them).

• If you established a Dial Direct connection to the remote computer, the 
Hang Up... checkbox will be available. Select the checkbox to close your 
connection automatically once the files have been transferred.

6. When you have finished exchanging files, close the Exchange window.

You can also use the Exchange service while controlling or observing a Timbuktu 
Pro computer. 

The Exchange Menu

When you open an Exchange session with another computer, the Exchange menu 
appears on the menu bar. The Exchange menu includes many of the options you 
control by buttons in the Exchange window.

In addition, the Exchange menu includes the following options:

• Rename renames the selected file.
• Get Info displays basic information about the selected file, including file size 

and location.
• Find Original resolves the selected alias and positions the file list on the orig-

inal file. If you select an alias and attempt to copy it, the alias will be copied 
instead of the original file.

• Find opens the Find Files window to search for files on the local computer. 
(See the online Help for information about the Find Files window.)

• Custom Icons turns custom icon display on and off. 
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Remote Control: Controlling or Observing a Remote 

Computer

You can use Timbuktu Pro to control or observe a remote computer. The desktop 
of the remote computer is displayed in a window on your screen. The window is 
updated as the other computer’s desktop changes.

While you are controlling another computer, you can perform any of the tasks that 
you could perform locally, including opening applications and creating new files. 
This means that a user with the Control privilege can remotely create, modify, or 
delete files without restriction, and can erase data from the host computer. This 
privilege, therefore, should be granted with caution.

While observing another computer, you can see the activity on its screen, but you 
cannot control it. This privilege is useful for diagnosing problems on a remote 
computer or giving a presentation.

If the remote computer’s screen resolution is higher than yours and you maximize 
your Control or Observe window, the Autoscroll feature is enabled so that you can 
view the entire remote desktop. To enable or disable Autoscroll when the screen-
sharing window is not maximized, open the Control menu and select the Auto 
Scrolling option. 

To control or observe another computer

1. Select the remote computer or establish a Dial Direct connection. (See 
“Chapter 4: Making a Timbuktu Pro Connection” on page 45.)

2. From the Service menu, choose Control or Observe. Or click on the Control or 
Observe service button.

Timbuktu Pro displays the remote computer’s desktop in a screen-sharing 
window. (Note that you may need to ask for permission or log in as a Regis-
tered User before the window opens.)

3. Click on the screen-sharing window to make it the active window. To return to 
your own computer, click outside the screen-sharing window.

If you have chosen the Observe option, you will be able to observe the screen 
only. If you have chosen the Control option, you can use your mouse and key-
board to operate the remote computer.
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4. If desired, click the Control menu to display a number of options that you can 
change during your screen-sharing session. (For details, see “The Control 
Menu” on page 36.)

5. To stop controlling or observing, close the screen-sharing window. Timbuktu 
Pro closes the window and ends the connection.

If a screen-sharing window doesn’t open, you may have one of the following 
problems:

• You have not been granted permission to use to the Control/ Observe 
service on the remote computer.

• Timbuktu Pro is not running on the remote computer.
• There is a network firewall between the computers.

While controlling a remote computer, you can start another Timbuktu connection 
to the same computer. Simply select another service from the Button Bar or the 
Service menu. Because you already have a connection open with the host, you 
will not need to provide user-authentication information.

Note: Timbuktu Pro does not support full-screen DOS sessions on Windows com-
puters. Press Option+Enter to switch the MS-DOS session from full-screen to win-
dowed mode.

Using Drag and Drop with Control

Timbuktu Pro takes full advantage of Drag and Drop capabilities. When control-
ling another computer, you can drag files from that computer directly across the 
border of the screen-sharing window to your own desktop.

Note: Drag and Drop is not supported when you are connecting through a firewall 
or a NAT router.

Sending CTRL+ALT+DEL or Force Quit to a Remote 

Computer

If you’re connecting to a computer that is running Windows, and need to log on, 
you’ll need to open the Logon Information dialog box. However, unlike with Win-
dows computers, you cannot simply press Ctrl+Alt+Delete on your Macintosh.

To open the Logon Information dialog box on a Windows computer, click the Con-
trol menu on your Macintosh and choose Send <Ctrl> <Alt> <Del>.
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The Logon Information dialog box is displayed on the remote computer, allowing 
you to enter your user name and password.

You don’t have to log on to Windows to use Timbuktu Pro with a remote Windows 
computer. You can exchange files with and send files to a remote computer when 
the Logon Information dialog box is displayed. However, FlashNotes are not dis-
played on the Windows system until after you have logged on.

If you do log on to Windows, make sure to log out before you end your Timbuktu 
Pro session, or other users will not be able to log on.

If you are controlling a Mac OS X computer and need to force-quit an application, 
click the Control menu and choose Send <Force-Quit>.

Notify: Requesting Notification When the Remote User is 

Active

Timbuktu Pro’s Notify service lets you leave a request to be notified when another 
Timbuktu Pro computer becomes active. This is a useful way to find out when the 
person you want to communicate with is available. You can then open another 
Timbuktu Pro connection (for example, if you need to ask for permission) or con-
tact the user of the remote computer. 

To request notification of another user’s presence

1. Select the remote computer or establish a Dial Direct connection. (See 
“Chapter 4: Making a Timbuktu Pro Connection” on page 45.)

2. From the Service menu, choose Notify. Or click the Notify service button. The 
Notify window is displayed. (Note that you may need to ask for permission or 
log in as a Registered User before the window opens.)
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“Waiting for activity” appears near the top of the window. Below it are the fol-
lowing fields:

• Last Active  tells you the date and time the remote user last moved the 
mouse or pressed a key. This field changes to Became Active  the next 
time the remote user moves the mouse or presses a key, and displays 
the new date and time.

• Idle Time tells you how much time has passed since the remote user has 
used that computer.

3. While you’re waiting, you can work on tasks in other windows. You can mini-
mize the Notify window, but don’t close it.

4. When the remote computer becomes active, the message in your Notify win-
dow changes to

 “Name  has become active.”

If you have selected the Come to Front when Active checkbox in the Notify 
window, it will appear on your desktop automatically.

5. You may now contact the user of the remote computer.

Once you have been notified of the remote user’s return, you can close the Notify 
window and contact the other user.

If the Notify window is acknowledged while you are away from your computer, the 
remote user may no longer be at their computer by the time you get back. You can 
start the notification process again by clicking the Notify Again  button.
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Chat: Chatting with a Remote User

The Chat service lets Timbuktu Pro users post messages to one another interac-
tively. For example, if you are in the midst of a file transfer session, a Chat session 
lets you discuss the file transfer with the other user. You can even chat with multi-
ple remote users in a single Chat window.

To chat with a remote user

1. Select the remote computer or establish a Dial Direct connection. (See 
“Chapter 4: Making a Timbuktu Pro Connection” on page 45.)

To start a multiple-user Chat session, select each computer in an address 
book or the TCP/IP Scanner.

2. From the Service menu, choose Chat. Or click the Chat service button. The 
Chat window is displayed. (Note that you may need to ask for permission or 
log in as a Registered User before the window opens.)

3. Type your first message and press Return or click the Send  button.

4. Your message is copied to the transcript panel in the upper part of the win-
dow and to the Chat window on the remote computer. Type more messages 
immediately or wait for a reply from the other user.

5. The reply is displayed below your message in the transcript panel. You can 
keep typing messages back and forth as long as you like.

6. To add other users to the Chat session, click the Add button and select 
another computer. (To display the Add button, click the disclosure triangle 
next to the host computer name.)
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7. When you’ve finished chatting, click the click the red Close button. If the 
other party disconnects first, the session is ended, but the Chat window 
remains open.

8. After you have disconnected, you can save a transcript of the chat session to 
a text file. 

Click the File menu and choose Save Transcript . In the Save dialog box, spec-
ify the destination file name and folder.

9. Click the red Close button to close the chat window.

Intercom: Speaking to a Remote User

The Intercom service lets Timbuktu Pro users talk to each other through their com-
puter’s audio hardware.

To speak to another Timbuktu Pro user

1. Select the remote computer or establish a Dial Direct connection. (See 
“Chapter 4: Making a Timbuktu Pro Connection” on page 45.)

2. From the Service menu, choose Intercom. Or click the Intercom  service but-
ton. The Intercom window is displayed. (Note that you may need to ask for 
permission or log in as a Registered User before the window opens.)
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Note: If the sound card on your computer or the remote computer is already 
being used by another application—for example, recording or playback—you 
won’t be able to begin your Intercom session until the other application has 
been closed.

3. When the Intercom window is displayed, you can begin speaking with the 
remote user.

Note: The Intercom window does not automatically stay on top of the screen 
when other application windows are run in the foreground.

4. When you’ve finished talking, click the red Close button.

Invite: Inviting a Remote User to Access your Computer

The Invite service allows you to invite other users to visit your computer. Once you 
have specified a user to receive your invitation, you can select the type of invita-
tion you want to extend and send it to the remote user. The recipient will be able 
to use the service immediately or decline your invitation by closing the service 
window.

To invite a remote user to visit your computer

1. Select the remote computer or establish a Dial Direct connection.

2. From the Service menu, choose Invite. Or click the Invite button on the Button 
Bar. The Invite window is displayed.

3. In the Invite window, specify the service you wish to invite the other user to 
access. Then click Invite.

4. The Invite window appears on the remote computer, displaying the service 
you invited the remote user to access. The invited user may begin using the 
service or close the window to cancel it.

If the remote computer has enabled the Invite service, the Service menu’s Invite 
command will allow you to ask another user to observe your screen, control your 
computer, or use any of the other sharing or collaboration services.
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If the remote user has granted Guest User access to his or her Invite service, the 
service you selected from the Invite drop-down list will start immediately. If the re-
mote user has not granted Guest User access to the Invite service, you will need 
to either wait for permission from the remote user or log on to the remote user’s 
computer as a Registered User.

The remote user has the option of accepting or turning down your invitation. If the 
invitation is accepted, the Invite service you selected should be in session.

Profile: Generating a System Profile for the Remote 

Computer

The Profile service allows you to automatically run the Apple System Profiler on a 
remote Macintosh computer and return the results to your computer as a text file.

To generate a system profile for a remote computer

1. Select the remote computer or establish a Dial Direct connection.

2. From the Service menu, choose Profile. Or click the Profile button on the But-
ton Bar. The Profile window is displayed, and a Save window opens.

3. In the Save window, specify a file name and location for the system profile to 
be saved on your local computer. Then click Save.

4. The system profile is generated on the remote computer and saved as a text 
file in the location you specified. When the process is complete, the Profile 
window indicates that the profile has been saved and displays the file name.

Click the Open button to open the saved system profile in your default text 
editor.



Chapter 6: Security

This chapter describes the essential steps to prepare your computer to receive in-
coming Timbuktu Pro connections. You must set up user access privileges and 
turn on transports to enable them access. To allow remote users to dial directly 
into your computer, you must also set up your computer for Dial Direct access.

To allow more complete control over incoming connections, you also have the 
ability to disconnect remote users and keep them from connecting.

Finally, you can protect your own Timbuktu Pro settings using a Master Password.

Setting User Access Privileges

The Define Users dialog box lets you specify privileges for the three kinds of Tim-
buktu Pro users that may access your computer: Guest Users, Ask for Permission 
users, and Registered Users.

When you grant a service to Guest Users, any Timbuktu Pro user may access that 
service on your computer without entering a user name and password or asking 
for permission. The remote user is allowed to use any of the services assigned to 
Guest Users in the Define Users dialog box.

To specify Guest User privileges

1. From the Setup menu, choose Define Users. 

The Define Users dialog box appears.

In the Define Users dialog box, you can edit settings for Guest Users, Ask For 
Permission Users, and Registered Users. 
| 71
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2. Select Guest and click Edit.

3. Assign the desired services to Guest Users by clicking them.

Remember: any Timbuktu Pro user can now—without entering a password or 
asking for permission—connect to your computer using the services you 
have selected. If you grant the Exchange or Control privilege to all remote 
users, any remote user will be able to access all the files on your hard disk, 
as well as files on any network drive that you are currently logged into. DO 
NOT grant Exchange or Control privileges if your computer contains sensitive 
or confidential information. 

Services you define for Guest Users are automatically granted to all Regis-
tered Users as well. For example, if you grant the Send service to Guest 
Users, you cannot deny this service to Registered Users.

4. If you want to allow remote users to dial into your computer, select Let User 
Dial into Your Computer. For more information, see “Setting up Timbuktu Pro 
for Incoming Dial Direct Access” on page 76.

5. Click Save to confirm your newly defined Guest User services.

6. Click the close box to return to the Define Users dialog box.

Allowing Remote Users to Ask for Permission

When a remote user wishes to connect to your computer using a service you have 
not granted to Guest Users, the user may request permission to connect. Granting 
services to Ask for Permission users makes it possible for remote users to request 
that service on a one-time basis. When the user requests permission, you can 
choose whether or not to admit them. 

Remote users may ask for permission by beginning a Timbuktu Pro connection us-
ing the desired service. The Log In dialog box opens.
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After the remote user selects Ask for Permission and clicks OK, an alert is dis-
played on your computer that identifies the user and the desired service.

Click OK if you want to allow the connection.

To allow users to Ask for Permission

1. From the Setup menu, choose Define Users. The Define Users dialog box 
appears.

2. Select Ask for Permission and click Edit.

3. Assign the desired services to Ask for Permission users by clicking them in 
the scrolling list.

4. If you want to allow remote users to dial in to your computer on an ask-for-
permission basis, select Let User Dial into Your Computer. See “Setting up 
Timbuktu Pro for Incoming Dial Direct Access” on page 76.

5. Click Save to confirm your selections.

6. Click the close box to return to the Define Users dialog box.

Adding Registered Users

A Registered User can access your computer using any of the services that you as-
sign to his or her Registered User account. To access your computer, the Regis-
tered User must use a user name and password that you assign. The Registered 
User is allowed to change this password, subject to your password restrictions. 
(See “Password Rules” on page 33 for information about password restrictions.)

To define a Registered User

1. From the Setup menu, choose Define Users.

2. In the Define Users dialog box, click New. 

Timbuktu Pro opens a new dialog box in which you can define the settings for 
the new Registered User.

3. In the Name box, enter the desired user name for the Registered User.
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4. In the Password box, enter the Registered User’s password. (A password can 
be up to 15 characters long.) Reenter the password in the Confirm box.

You cannot close the New Registered User dialog box until the Password and 
Confirm boxes match exactly.

5. Assign the desired services to Registered Users by selecting or deselecting 
them in the scrolling list. All services are selected by default.

6. If you want to allow remote users to dial in to your computer on an ask-for-
permission basis, select Let User Dial into Your Computer. See “Setting up 
Timbuktu Pro for Incoming Dial Direct Access” on page 76.

7. Click Save to confirm your selections, and click the close box to return to the 
Define Users dialog box.

Opening Transports for Incoming Connections

Remote users have access to your computer only after you’ve enabled one or 
more of the transports in the Incoming Access dialog box. You may also enable 
and disable incoming access by selecting transports in the Connection menu.

When a network or dial-in transport is switched off, no remote user can use that 
transport to connect to your computer. Note that if you turn off a transport, you 
can still use that transport to make outgoing connections. Turning off a transport 
disables only incoming connections. 

When a transport is switched on, you can still limit access to individual services 
on your computer by creating user definitions in the Define Users dialog box (see 
“Setting User Access Privileges” on page 71).

To switch on a transport

1. From the Setup menu, choose Incoming Access. 

The Incoming Access dialog box appears.
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2. Click the checkboxes of the transports on which you want to allow incoming 
Timbuktu Pro connections.

3. If a checkbox is dimmed or if a transport doesn’t appear, make sure that the 
software associated with that transport is properly configured and try again. 

For details about the Dial Direct option, see “Turning on the Dial Direct Trans-
port” on page 76.

4. Close the Incoming Access dialog box.

Other Timbuktu Pro users can now establish connections to your computer over 
the selected transports.

Shutting Down Transports

A quick way to stop some or all incoming connections is to switch off incoming 
transports in the Incoming Access dialog box.

Switching off a transport prevents only incoming connections using only this 
transport. It does not prevent other applications on your computer from using the 
transport. Moreover, you can still use a switched-off transport to make outgoing 
connections.

You can switch any of your installed transports on or off at any time. Changes you 
make in the Incoming Access dialog box take effect as soon as you select or clear 
a check box.

To shut down a transport

1. From the Setup menu, choose Incoming Access.

2. In the Incoming Access dialog box, select or deselect the transports that you 
want to use for incoming access.

Note: If the feature associated with a transport has been disabled on the Fea-
tures tab in the Preferences dialog box, the transport will not be visible in the 
Incoming Access dialog box. For example, Dial Direct may not be available on 
some computers.

If a transport is visible but dimmed, the transport is not configured properly 
or a site administrator has restricted access to the transport.

3. Your changes take effect immediately. However, if a remote user is already 
connected to your computer using a transport that you turned off, that con-
nection will continue. To disconnect a remote user, see “Disconnecting 
Remote Users” on page 80.
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You can also use the Connection menu or the Timbuktu Pro Info dialog box as a 
shortcut to turn transports on and off. Choose a transport to change its status. 
Checked transports are turned on.

Setting up Timbuktu Pro for Incoming Dial Direct Access

This section explains the steps you’ll need to take to customize Timbuktu Pro to 
receive incoming Dial Direct connections. To set up your computer and modem to 
make outgoing connections, see “Setting Dial Direct Preferences” on page 39.

Configuring Timbuktu Pro for Incoming 

Connections

Most modem setup is required only if you intend to make outgoing Dial Direct 
connections. It is covered in more detail in “Setting Dial Direct Preferences” on 
page 39. 

However, before you can accept Dial Direct calls, you must turn on the Dial Direct 
transport to allow incoming Dial Direct access. Additionally, if you wish to use 
callback, you must specify a calling location and make sure that your modem is 
configured correctly.

Turning on the Dial Direct Transport

To enable Timbuktu Pro to answer incoming calls to your modem, you need to turn 
on the Dial Direct transport. From the Setup menu, choose Incoming Access. In 
the Incoming Access dialog box, select the Dial Direct checkbox to enable the Dial 
Direct transport.

If you don’t want Timbuktu Pro to answer incoming calls until you’re ready, leave 
the Dial Direct transport turned off until you need to accept an incoming call.

Note: If you set Timbuktu Pro to answer Dial Direct calls, make sure that you don’t 
have fax, ARA Personal Server, speaker phone, or other serial software set to 
answer incoming calls.
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Selecting a Calling Location

When you are setting up your computer to receive Dial Direct calls and call back, 
make sure that the calling location information is filled out accurately and that 
the correct calling location is selected. Selecting the correct calling location en-
sures that the correct dialing prefix will be used when the return call is made.

To select a calling location for callback

1. Open the New Connection window.

2. Click the Dial Direct tab.

3. From the Calling From drop-down list, choose the correct calling location. If 
you need to create a new calling location, choose Edit Calling Locations. See 
“Setting Your Calling Location” on page 42.

Configuring Your Modem

If your computer will be responding to any incoming Dial Direct connections by 
calling back, make sure your modem settings are correct on the Dial Direct tab in 
the Preferences dialog box. See “Setting Dial Direct Preferences” on page 39.

Setting Up Access Privileges for Remote Users

When you customize your Guest User and Ask for Permission User settings and 
create Registered Users, you must specifically grant Dial Direct access to each re-
mote user who will be allowed to dial in to your computer. You must also specify 
callback options for each remote user to whom you grant Dial Direct access. (See 
the following section, “Choosing Callback Options,” for information about call-
back.)

Dial Direct access options for Guest Users and Ask for Permission Users are set for 
all users of the same type, but Registered User options may be set individually for 
each user.

To grant Dial Direct access

1. From the Setup menu, choose Define Users.

2. Select the user account for which you want to set callback options—Guest 
Users, Ask for Permission Users, or a Registered User—and click Edit. (Or cre-
ate a new Registered User account.)
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3. In the lower panel, select the Let User Dial Into Your Computer checkbox.

4. From the drop-down list, select one of the responses to a request for call-
back. The callback feature and callback request options are explained in the 
following section, “Choosing Callback Options.”

5. Close the dialog box and return to the Define Users dialog box.

Choosing Callback Options

When your computer receives a Dial Direct call from a remote computer that re-
quests callback, your modem automatically hangs up and calls back to the calling 
computer. Callback is primarily a security feature, but it can also be used to re-
verse the charges on a dial-up connection.

Callback is performed only if the calling party selects Request Callback when plac-
ing the call. If callback is required but the remote computer does not request it, 
the remote user will receive an error message indicating that they must request 
callback. Conversely, if the remote computer requests callback but it is not al-
lowed, the remote user will receive an error message indicating that callback is 
not allowed.

Before a remote computer can receive callback from your computer, you must 
specify how your computer will respond to the callback request. You must specify 
callback options separately for Guest Users, Ask for Permission Users, and for 
each Registered User who will be dialing in to your computer.

Remember that these settings take effect only if the calling computer requests a 
callback from your computer.

Refuse Callback Request from Caller

This option—the default selection—means that your computer will not redial the 
calling party under any circumstances. If the caller has requested callback, Tim-
buktu Pro hangs up and displays an alert message to the caller.

Use this option to ensure that a Dial Direct connection from this remote user is 
not charged to your telephone bill.

Callback Request is Caller’s Choice

This option gives the calling party the option to request callback. If the caller has 
requested callback, Timbuktu Pro hangs up and dials the remote user’s tele-
phone number. If callback isn’t requested, Timbuktu Pro allows the incoming con-
nection to continue.
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Use this option for callers who may be calling from a number that your computer 
can’t reach, such as a hotel room. If the number can be successfully called back, 
the user initiating the connection can request callback.

Require Callback Request from Caller

This option forces the calling party to request callback to a number supplied by 
the caller. If callback isn’t requested, Timbuktu Pro hangs up and displays an alert 
message to the caller.

Use this option when security is important enough to justify calling back and 
when you can trust the caller to supply his or her own callback number.

Require Callback to Specific Number

This option causes Timbuktu Pro to call back if the caller has requested callback 
and if the caller’s current calling location, specified on the caller’s Dial Direct tab, 
matches the number you specify at the bottom of the panel. If not, Timbuktu Pro 
hangs up and displays an alert message to the caller.

Use this option when security is so important that your computer should be al-
lowed to call only the number you specify. This option prevents the caller from 
making a Timbuktu Pro connection to your computer from more than one calling 
location.

You may wish to use this option if you dial in to your office computer from your 
home computer. You ensure that only you can access your computer by modem.

Keeping Users Out

To prevent anyone from connecting to your computer while Timbuktu Pro is run-
ning, you can remove all services from Guest User access, delete all Registered 
Users, and prevent users from asking for permission to connect. You may also 
turn off all incoming transports, which still allows you to make outgoing connec-
tions (see “Shutting Down Transports” on page 75). 

When you quit Timbuktu Pro, all Timbuktu Pro windows and outgoing service ses-
sions close. However, by default, the Timbuktu Host remains running. Unless you 
have turned on the Only Accept Incoming Connections When Application is Open 
option on the General tab in the Preferences dialog box, remote users can still 
connect to your computer using the access privileges you have defined.
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To shut down the Timbuktu Host, which has the effect of preventing incoming 
connections when the main Timbuktu Pro application is shut down, activate the 
Only Accept Incoming Connection... option . For more information, see “The Tim-
buktu Host” on page 26 and “General Preferences” on page 28.

Disconnecting Remote Users

When remote users are accessing your computer, you still have control over their 
actions. If you need to disconnect a remote user, you may do so at any time.

Disconnecting All Remote Users

If you wish to disconnect all remote users from your computer (for example, you 
wish to shut down Timbuktu Pro), choose Disconnect Current Users from the Con-
nection menu. Timbuktu Pro immediately terminates sessions with all the remote 
users listed below this command.

Disconnecting a Specific Remote User

If you wish to disconnect a specific remote user from your computer (for example, 
the user is using a service you did not intend to grant), choose the remote user 
from the remote user list in the Connection menu. Timbuktu Pro immediately ter-
minates the session with the selected remote user.

The Connected Users Window

You can monitor and disconnect remote users with the Connected Users window. 
From the Window menu, choose Show Connected Users.
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The Connected Users window lists all current connections to your computer. EAch 
user name is preceded by an icon, which indicates the service in use. (See the on-
line Help for a list of icons.) When the remote user disconnects, their name disap-
pears from the window. You may check for previous users in the Connection menu 
or the activity log.

You may use the Connected Users window to disconnect a remote user at any 
time. To disconnect a remote user, select the user in the list and click Disconnect.

Using a Master Password

When you create a Master Password, you can protect access to those parts of Tim-
buktu Pro that allow you to change Timbuktu Pro’s configuration and security set-
tings—the Preferences, Incoming Access, and Define Users dialog boxes. After 
you’ve created a Master Password, you can specify which areas of Timbuktu Pro 
are password-protected. When you attempt to access the password-protected ar-
eas, you will need to enter your Master Password before you can proceed.

You create your Master Password on the Master Password tab in the Preferences 
dialog box. See “Master Password Preferences” on page 30 for a detailed 
procedure.
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Logon Information dialog box, displaying  64
Look service. See Observe service

M
making a Timbuktu Pro connection  48–56
manually starting Timbuktu Pro  26
Master Password tab (Preferences dialog box)  

30–32
master passwords  30, 81

removing  32
setting  31

messages received folder  34, 57, 60
Messages Received tab (Preferences dialog box)  

34–35
Messages Received window  60
modem configuration files  41
modem connections. See Dial Direct; Dial Direct 

connections
Modem Picker  41
modem requirements (Dial Direct connections)  

18
modem setup  9
monitoring remote connections  80

N
NAT routers, connecting to computers behind  37, 

39
New Connection window  45–47

Address Books tab  46
connection tabs  46–47
Dial Direct tab  46, 54
TCP/IP Scanner tab  47, 49–50
TCP/IP tab  16, 47

new features in Timbuktu Pro  11
Notify service  15, 65, 65–66

defined  7
Notify window  65

O
Observe service  13, 63–65

defined  7
preferences  35

observing a remote computer  63–65
online Help  18
opening Help  18
opening Timbuktu Pro  25

P
Password Rules tab (Preferences dialog box)  33–

34
password rules, setting  33
performance

improving during screen-sharing  14
port settings, specifying  39
preferences  27–41

Dial Direct connections  39
messages received folder  34
password rules  33
protecting your settings  30
remote control  35
screen-sharing  35
setting email address  36
sounds  32
specifying a proxy server  38

Preferences dialog box  27–41
Control/Observe tab  35
Dial Direct tab  39
Features tab  29
General tab  27
IP Locator tab  36
Messages Received tab  34
opening  27
Password Rules tab  33
Proxy Server tab  38
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Preferences dialog box (continued) 
Sound tab  32
TCP Contact Port tab  39

preventing incoming connections  26, 79
Profile service  70

defined  7
protecting your Timbuktu Pro settings  30
protocols for communication  8
Proxy Server tab (Preferences dialog box)  38
proxy server, specifying  38
Public Visitors. See Guest Users

Q
QuickTime recording of screen-sharing sessions  

14
quitting Timbuktu Pro  26

vs. shutting down  26

R
receiving FlashNotes, messages received folder  

34
refusing callback requests  78
Register Public Address option  37
Registered Users  15

connecting as  49
creating  73
Log In dialog box  49
setting password rules  33
specifying privileges  71

remote computers
behind NAT routers  37, 39
connecting

as Registered User  49
using an address book  51
using email address  16
with Connection Documents  55

connecting to  48–56
controlling  13, 63
Dial Direct connections  54
generating a system profile  70

remote computers (continued) 
re-establishing a connection  51
scanning network for  16
transferring files  14

remote control  13, 63–65
setting preferences  35

remote users
access levels  15
allowing Dial Direct connections  76
chatting  67
disconnecting  80
monitoring  25, 80
preventing incoming connections  79
preventing simultaneous connections  28
setting Dial Direct privileges  77
speaking to  68

removing Timbuktu Pro from your computer  23
requesting Ask for Permission access  49
requesting notification  65
requesting permission  49

Log In dialog box  49
requiring callback  79
restricting access to your computer  43

S
saving addresses to address books  52
saving chat sessions  68
saving connections  17
scanning for remote computers  16
screen-sharing  13, 63–65

accelerating performance  14
recording sessions  14
setting preferences  35
See also screen-sharing window

screen-sharing window  63
AutoScrolling  63
troubleshooting  64

searching for remote computers  16
Internet Locator  48
TCP/IP Scanner  49
using email address  36
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security  15, 43, 71–81
controlling access to your computer  43
disabling transports  75
disconnecting remote users  80
enabling transports  74
Guest User access  71
keeping users out  79
master passwords  81
monitoring remote users  80
setting a master password  30
setting password rules  33
setting up for Dial Direct access  76

Send service  14, 57, 57–60
adding files to a FlashNotes  58
defined  7
drop senders  17
messages received folder  57
messages received options  34
Messages Received window  60
Send Status dialog box  59

Send Status dialog box  59
Send window  57
sending files to remote computers  14, 57

drop senders  17
Send Status dialog box  59

services  7, 57–70
Chat  67
Control  63–65
Exchange  61
Intercom  68
Invite  69
Notify  65
Observe  63–65
Profile  70
Send  57
turning on and off  29
See also individual service names

setting up Timbuktu Pro for Mac OS  25–43
shutting down Timbuktu Pro  26

vs. quitting  26

software requirements  18, 19
Sound tab (Preferences dialog box)  32
speaking to a remote user  68
splash screen, turning on and off  28
starting Timbuktu Pro  25, 26
system profile, generating  70
system requirements  18

T
TCP Contact Port tab  39
TCP/IP addresses, entering  47
TCP/IP Scanner  16, 47, 49–50

zones  50
TCP/IP Scanner tab (New Connection window)  

47, 49–50
TCP/IP tab (New Connection window)  16, 47, 48–

49
making a new connection  48

Timbuktu Host  13, 25
disabling  26
preferences  27

Timbuktu Pro
activation key  21
application icon  16
installing  21–23

on Mac OS X  21–23
introduction  7
new features  11
preferences. See preferences
quitting  26
service shortcuts  55
services. See services
setting up  25–43
shutting down  26
starting  25
starting manually  26
system requirements  18
uninstalling  23
upgrading. See upgrading Timbuktu Pro

Timbuktu Pro Connection Documents  17, 55
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Timbuktu Pro connections  45–56
Button Bar  47
New Connection window  45
through firewalls  10

Timbuktu Pro Extension. See Timbuktu Host
Timbuktu Sender  14, 17
transcripts of Chat sessions  68
transports  9

Dial Direct  76
opening for incoming connections  74
shutting down for incoming connections  75
TCP/IP  9
turning on and off  25, 29

troubleshooting. See Troubleshooting in the 
online Help

Trusted Visitors. See Registered Users

U
unistalling Timbuktu Pro  23
upgrading Timbuktu Pro

on Mac OS X  22
using the address books  51

W
windows

Chat window  67
Connected Users window  80
Exchange window  61
Intercom window  68
Invite window  69
Notify window  65
screen-sharing  63
Send window  57

Windows Logon Information dialog box, 
displaying  64

Windows NT/Windows 2000/Windows XP
logging on  64
sending CTRL+ALT+DEL  64
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